Student Overview Guide to conneX

What is conneX?

Is an online Learning and Collaboration System that allows students, instructors and researchers to interactively create and participate in shared websites, social networking sites, Internet file-sharing and online teaching tools. It provides instructors and students with an alternative way of interacting to exchange course and academic information.

conneX has been deployed using Sakai Software which is developed by the Sakai Project. The Sakai Project is an open source development project maintained by a collaboration of Universities to develop specialized software for instructors, students and researchers.

💡 Online Help in conneX

Help is the last link on the left hand menu bar on every page. There is also a 🔎 on every panel in conneX is a link to its context sensitive online help page. Either of these links will take you to the following pages:

- [https://connex.csc.uvic.ca/portal/help/main](https://connex.csc.uvic.ca/portal/help/main)

Accessing conneX

The main login gateway page for conneX ([https://connex.csc.uvic.ca](https://connex.csc.uvic.ca)) can be accessed using any of the following web browsers:

- Internet Explorer 7+
- Mozilla Firefox 2.5+

*Please note that there are known compatibility problems when connecting to conneX with other web browsers, including: Safari, Chrome and Opera.*

Activating your Account

conneX login privileges are available to all current Computer Science and SENG students with a valid CS or CSc computer account - a UVic NETLINK account is not sufficient to be able to log into conneX, you must activate your CSc account in order to login to conneX
For more information on how to activate a Computer Science Account, please see the following:

- [http://accounts.csc.uvic.ca](http://accounts.csc.uvic.ca)

### Logging in

To login to conneX ([https://connex.csc.uvic.ca](https://connex.csc.uvic.ca)), enter your CSc or CS username and password into the login panel of the main banner at the top of the gateway page, and click "Login".

Upon logging in you will be able to access all Course Sites for any course you are registered in.

### Short-cut Course Site URL's

Standard URL’s are defined for existing courses created in conneX. The standard URL format is:

- [https://connex.csc.uvic.ca/courses/csc<course number>](https://connex.csc.uvic.ca/courses/csc<course number>)
- [https://connex.csc.uvic.ca/courses/seng<course number>](https://connex.csc.uvic.ca/courses/seng<course number>)
- [https://connex.csc.uvic.ca/portal/site/directory](https://connex.csc.uvic.ca/portal/site/directory) - directory index of all available sites

*Please note that for courses that are cross-listed, currently short-URL’s are only created for lowest course number of the cross-listed group. Students can still access all of the sites through site tabs and long URL’s.*

### Web Navigation in conneX

#### 🔉 The RESET Button

Using your web browser "BACK" button will not take you to the previous page in conneX, but it will take you to the previous Tool you were using. Use the Reset Button, the small double arrows in the top right left hand corner of every panel, to return to the starting navigation point of the current tool you are using.
The Tools Menu

The left hand grey menu bar in conneX is referred to as the Tools Menu.

Every site in conneX will have a list of Tools that you can choose from on this menu which will provide you different types of information. Your instructors can add different Tools to their Course Sites to allow you to interact with them and other students, as well as obtain course materials.

Site Tabs

After logging in, you will see a series of tabs across the top of the conneX web page. Each tab corresponds to a conneX website that you are a participant of. You should see a tab for all of the courses you are registered in that are available in conneX, as well as the default private website: "My Workspace".

The Site Tab that is currently highlighted in white is the active website you are viewing, to change conneX website, click the dark grey tab that corresponds to the website's name - this will bring it to the foreground and make it the active website.
My Workspace

"My Workspace" is your personal/private workspace in conneX that allows you to see all personal messages and events that are directed to you personally. Your Home Page in "My Workspace" has 4 panels in it with helpful information in it:

- Message of the Day - contains broadcast information from Jane and Sharon in the CSc Department Office. It often has useful information for students on upcoming scholarships, bursaries, grants, and job opportunities from researchers.
- Calendar - upcoming events and deadlines posted by your instructors to you personally.
- Recent Announcements - announcements and messages posted by your instructors, or sites that you have enrolled in.
- Support Info - technical support information from the Department's ITST support group.

Site Memberships

As a student taking a Computer Science course, you are automatically enrolled as a participant in all available conneX Course Sites for any courses you are taking (if you have just registered in a course, please allow 12-24 hours for course registration data to be uploaded from the UVic Registrar's office).

Other optional sites may be available to you to join if you wish (interest groups or research sites like Women in Computer Science, or the Programming Club. Use the "Membership" tool from "My Workspace" to see a list of other available websites that you can join if you wish. Publicly available conneX sites will be listed in a scroll down list, and each site will have a "join" link that will allow you to become a member of that site.

Course Websites

A course website is a site that has been created by your instructor to provide you with course material online and also provide you with electronic methods of interacting. These sites may have chat groups, forums, online assignment submissions, announcements, and a variety of other tools which will be presented on the left hand menu.

As a student in Computer Science or Software Engineering, you will be automatically added as a participant in all course websites that you are officially registered in.
Project Websites

Project websites are very similar to course websites except that membership in the site is now tied to course registration data. Individuals and groups can create their own project sites to use as a collaboration site for their own specialty interests.

Once a project site has been created, it can be added to the site directory and made available to other participants who may want to join.

ITSupport, LabsPage and Gateway Sites

Below is a list of Department sites that students will find useful:
- 6 -

- [https://connex.csc.uvic.ca/portal/site/itsupport](https://connex.csc.uvic.ca/portal/site/itsupport) - technical support documentation maintained by the Department's ITST group.
- [https://connex.csc.uvic.ca/portal/site/labspg](https://connex.csc.uvic.ca/portal/site/labspg) - the Lab Consultants site where students can find information about undergraduate computer labs.
- [https://connex.csc.uvic.ca/portal/site/gateway](https://connex.csc.uvic.ca/portal/site/gateway) - gateway login page, it also has links to external sites and historical events information.
- [https://connex.csc.uvic.ca/portal/site/directory](https://connex.csc.uvic.ca/portal/site/directory) - main site directory for all public conneX sites.

**Commonly Used Site Tools**

Please note that conneX has a very long list of Tools and features that faculty and staff can use to interact with each other. A short overview is provided below of some of the most commonly used tools.

A full list of all tools available and how to use them can be found on the conneX online help tool:

- [https://connex.csc.uvic.ca/portal/help/main](https://connex.csc.uvic.ca/portal/help/main)

**Assignment Tool**

One of the more common tools used by instructors is the Assignment Tool which your instructor may configure to allow you to complete and submit your assignments electronically online.

**Submitting an Assignment**

1. Open the site for the course or project with the assignment.
2. In the menu bar, click Assignments.
3. Click the name of the assignment to open it. *Note: The assignment must have a status of "open" for you to be able to work on it.*
4. To work on the assignment, follow the instructions from your instructor. You may need to type something into the text box, or perhaps add an attachment, or both.
5. To add an attachment, click the Add Attachments button in the assignment window. In the window that appears, you have several options:
   a. To attach a local file from your computer, under Items to attach, type the filename in the box provided, or browse for the file, select it, and click Browse. A small icon representing the item will appear above, under Items to attach.
b. To attach an item from the resources already in this course website, under Select a resource, click Attach a copy next to the appropriate resource.  
c. When you are done adding attachments, click Finish.

6. If you'd like to see how your assignment will look to your instructor or project leader, click Preview.

7. If you want to save your assignment to complete later, click Save Draft at the bottom of the screen. When you want to reopen it, you'll find it listed in the assignment list with a status of "In progress".

8. You must submit an assignment when you have finished, click Submit at the bottom of the screen. You will receive a confirmation screen and an email informing you of successful assignment submission.

Resubmitting an Assignment

Your instructor may allow you to resubmit your assignment multiple times until the due date occurs, at which point your instructor will grade the last copy submitted. To resubmit an assignment:

1. In the menu bar of the course site, click Assignments.
2. Click the title of the returned assignment you want to resubmit.
3. You will see the original assignment and your original submission. In the box labeled "Enter below for resubmission", edit or paste your revised submission for the assignment.
4. When you are finished revising your assignment, click Resubmit. Alternatively, you can click Save Draft to save your submission and continue working later.

Checking your Assignment Grade

To check your grade on an assignment, follow these steps:

1. In the menu bar, click Assignments. When the Assignments page appears, you'll see the title of your assignment and information about its status.
2. Click the title of the assignment for more details. You'll see when your assignment was graded as well as the original instructions. Your instructor may have added comments to the text that you submitted; if so, these should appear in red text.
3. Click Done to return to the Assignments main page. You may need to take further action (for example, if your instructor has made suggestions and asked you to resubmit the assignment). After you've done the needed work, you can preview your changes, resubmit your assignment, or save it as a draft.

A more detailed tutorial on how to use the Assignment Tool is available here:
Chat Room Tool

You can use the Chat Room tool for real-time, unstructured conversations among site participants who are signed on to the site at the same time.

Reading Chat Room messages

To read messages in the Chat Room, do the following:

- In the menu bar, click Chat Room.
- To see who is presently in the Chat Room, look under "Users in Chat" on the right side of the screen.
- Messages appear in chronological order, with the most recent at the bottom. Messages will always identify the sender.
- To hide or display the date or time messages were posted, select the appropriate option from the “View” drop-down list: Time Only, Date and Time, Date Only, or Neither Date or Time.
- To limit the list to messages from only the past three days, click Past 3 Days. To return to a view listing all messages, click All Messages.

Posting Chat Room messages

To post a message, follow these steps:

- In the text box at the bottom of the window, type your message, and then click Add message. Note: No one will be able to see your message until you click Add message, but once you do, only an instructor or a participant who has special permission can delete your message.
- To discard a message that you haven't sent yet, click Clear.

Deleting Chat Room messages

You can only delete a Chat Room message if the instructor has granted this permission to students. To delete a message, simply click the trash can icon next to your name of the posting, and then click Delete. If you don't see a trash can icon, you don't have permission to delete the message.
Resources Tool and Opening Files

When you click Resources in the menu bar, you will see a list of the site's resources and folders containing resources. You can then do the following to browse through the available material:

- To view a resource, click the name of the resource, or the icon next to it.
- To view the contents of a folder, click the folder icon next to the folder name or the name itself to open it, or click the black arrows to the left of "Title" to expand all the folders (i.e., make their contents visible).
- You can navigate between resources and folders using the "Location:" path above the resource list; simply click a folder name in the path to go to that folder. You can also click the icon of a folder with an arrow in it to go up one level.
- You can sort the resources by title (click Title), resource creator (click Created by), date last modified (click Modified), or size (click Size). To reverse the order, click any of these links again.